
Getting Started
Double-click the WWPlus icon to start the program.    The first time that the program starts it will be a full 
program window. Click the "folder" icon at the left end of the icon bar, and then browse for image files to 
add to the wallpaper queue.    There will be normally be images in your Windows directory, and you may 
have others which you have obtained.    If the images are small ones which you would like to have "tiled," 
check that option in the dialog.    After you have selected OK in the dialog, you will see the files listed in 
the queue.    Double-Click one and see it become your wallpaper.

In later sessions, once images have been added, the program will start as an icon which you may double-
click at any time to show the main window.    If you have chosen the hidden icon option, the program will 
not be visible when started.    Simply start it a second time and it will become visible.

Take a moment to familiarize yourself with the program elements on screen.    If you press the F1 key, this 
help file will be displayed, with information about the part of the program you are using.

When you move your mouse pointer across the toolbar icons and some other screen elements a small 
"Tool Tip" will appear to give you a better idea about what the icon does.    You may turn these captions off 
if you wish, via the Preferences menu.

There are a number of options for how an image may be displayed.    Look for these topics in the help file:

Tiling.
Resizing Wallpaper to fit Screen.
Adjusting Wallapaper Placement.
Gamma Adjustments.

There is a built in Picture Editor with which you may change images in a variety of ways.

The Screen Saver Configuration Dialog is used to setup the screen saver with many options.

There are a number of items in the Wallpaper, Screen Saver, and Preferences menus that affect the way 
the program operates.



Program Description
WWPlus is a program that provides various tools to manage Windows Wallpaper.    It is a wallpaper 
changer, editor, and file converter.    The program includes a Screen Saver module that turns your 
wallpaper files into screen-covering images for entertainment, security, and to avoid image burn-in.    
Sixteen transitional effects are available for screen saver changes.

Users gain substantial disk space by using compressed image formats as Windows wallpaper.    WWPlus 
includes tools that will convert images to and from these additional formats.

Editing features include: Crop, Rotate, Re-size, Stretch, Sharpen, Soften, and alteration of Brightness, 
Contrast and Gamma.

Individual wallpapers may be positioned on the screen, and the program will "remember" their positions 
for future display.    Images may be resized on-the-fly to full screen or a user-set limit.

WWPlus has a provision for reducing the colors in a 256-color image to 16 for VGA display, and for 
reducing True-Color (16 million colors) images to 256 (or 16) colors.

There is a Thumbnail function, which will display a small copy of all the wallpapers in a queue for easy 
selection.

Multiple "queues" (configuration files) may be maintained, each saved under a distinctive name.



Reduce colors to 16
Reduce colors to 256
These menu options are enabled when there are more than 16 colors or more than 256 colors, 
respectively, in the image displayed in the Picture Editor.    When an option is selected, WWPlus will 
"dither" the image to 16 or 256 colors



Caption Bar
The Picture Editor's caption bar will display information about the displayed image.    The format is NAME 
WIDTHxHEIGHTxCOLOR DEPTH.    During crop selection routines, the caption will show "crop" with the 
size of the selected area.
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Thumbnail Display
Small images of each of the bitmaps in your Wallpaper Queue are shown when you select the "View 
image thumbnails" option on the Images menu, or click on the Preview area to the right of the queue list. 
Depending on your computer speed and the number of images, it may take quite a while to load all of the 
images until they have been built once.    See Dynamic Thumbnailing for more information about how 
thumbnails are built.    Subsequent displays will be much faster.    You may stop the load at any time by 
pressing the "Cancel Load" menu option (only visible while the images are loading), or pressing the 
Escape key, which will erase the Thumbnail screen.

The display of images is coordinated with the Wallpaper Queue list.    The image listed at the top of the 
queue will be found in the top row of the resulting display.    It may not be the first image, since the 
thumbnail screen works in sets of 5.

Once the images are loaded, you can move an image to the Picture Editor by clicking it once and then 
choosing Edit Picture in the File menu.    You can make an image the current wallpaper by clicking it once 
and then choosing Make Current Wallpaper in the File menu.    Either of these operations can be the 
default action when Double-Clicking an image - Choose between the two in the Preferences menu.    If 
you want to know the file name and path for a displayed image, press the mouse button down while the 
mouse cursor is over the image.    The window caption will change to display the file name.    When you 
select an image by clicking on it, the border of that image will turn blue.    You may then edit or delete the 
image with the appropriate File menu command



ASP Ombudsman Statement
This program is produced by a member of the Association of Shareware 
Professionals (ASP). ASP wants to make sure that the shareware principle 
works for you. If you are unable to resolve a shareware-related problem 
with an ASP member by contacting the member directly, ASP may be able to 
help. The ASP Ombudsman can help you resolve a dispute or problem with 
an ASP member, but does not provide technical support for members' 
products. Please write to the ASP Ombudsman at 545 Grover Road, 
Muskegon, MI 49442-9427 USA, FAX 616-788-2765 or send a CompuServe 
message via CompuServe Mail to ASP Ombudsman 70007,3536



Dynamic Thumbnailing
WWPlus creates a small thumbnail image for each of the files in a queue.    Because it takes time to read 
a file and make the small thumbnail, the program waits until the file is being read for another purpose and 
then makes the thumbnail and stores it in the .QUE database file.    When you click on a file in the queue 
list, the thumbnail will be displayed in the Preview area.    If no thumbnail has yet been created the 
preview will remain blank and a button will appear for creating a thumbnail if desired.    If you find that 
having the thumbnail automatically displayed slows your operations too greatly you may turn the feature 
off via the 'Disable Auto Preview' option in the Preferences menu.    After disabling Auto Preview, you will 
always get the Preview button when a file is selected.

There are four circumstances when a thumbnail will be created: When the image becomes a wallpaper; 
when an image becomes a screen saver image; when the thumbnail screen is invoked (see ThumbNail 
Display); and when the Preview button is clicked.    Disabling Auto Preview will remove the first two 
automatic builds, which may allow an image to be used that otherwise would be too large in memory.

If an image is changed by editing, the program will detect that a change has occurred and rebuild the 
thumbnail when one of the four circumstances next occurs.    If, before such a rebuild, you click on an 
altered file in the list it will not be displayed; this is treated as though the thumbnail does not yet exist.



Speed vs. File Size
There is a tradeoff between program speed and the amount of compression used on images.    
Uncompressed .BMP files will display far more rapidly than the most compressed .GIF files, with .PCX 
between for both speed and compression.    .TIF and .TGA are normally used for pictures containing 
32,000 or more colors; neither offers significant compression over .BMP, and both are slower.    For 24-bit 
(16-million color) images, WWPlus can use .JPG format, which offers great compression, but is very slow 
and will cause some loss of image quality.

Speed is of less concern when changes are made by the system.    Both .GIF and .JPG files are read in 
the background during timer-initiated changes, to reduce the impact on foreground operations.    Long-
time users of WWPlus should note that this is new with version 2.5.    Prior versions would lock the system 
up during wallpaper and screen saver changes, requiring you to wait for their completion before resuming 
background tasks.

Note for users of compressed disk programs (Stacker, DOS 6 DoubleSpace, etc):    There is no space 
advantage to using compressed file formats with compressed drives (other than JPEG - see File 
Formats). You will lose the speed without gaining space, since your compression program cannot further 
compress a .GIF file.    Use .BMP in this case.

If you have chosen a wallpaper file with more colors than your display can show there will be additional 
delay while the program changes the color depth.    If you intend to use the image regularly you may want 
to use the editor to permanently lower the color depth to match your display.

For more information about the pros and cons of the file types, see File Formats.



Display Order
The Display Order option in the Preferences submenu of the Wallpaper menu or on the toolbar allows you 
to choose Random or Sequential display.    Random display will cycle through the list of wallpapers in no 
apparent order.    Sequential will display them in the order in which they are listed in the Wallpaper Queue. 
When changing from random to sequential, the display will continue from the currently displayed 
wallpaper.    Sequential order is good for slide show effects.



Up and Down Buttons
WWPlus offers a choice between alphabetically sorting files in a queue, or listing them in the order in 
which they were added - see Sort Image Files for more details - and also allows unsorted queues to be 
manipulated by the up and down buttons.    These buttons will not be enabled for sorted queues.

Use these buttons to organize the files in a queue in a desired order (for sequential display, or simply to 
manage the files better).    The buttons will only be visible when one or more files are selected in the 
queue.    If several non-contiguous files are selected and an up or down arrow is repeatedly clicked, the 
files will maintain their separation until reaching the top or bottom of the list, at which point they will bunch 
together until all are contiguous at the beginning or end.



Sort Image Files
This option, under the File menu, has two options in a sub-menu: Sort by Name, or UnSorted.    The first 
is an alphabetical sort that also will include the drive and path when those are showing (see List Details).  
When new image files are added, they will be placed immediately in their proper place. 

UnSorted queues will list files in the order in which they were added.    New files will always add to the 
end of the list.    You may select one or more files in an unsorted list and manually move them with the Up 
and Down Buttons.    You may switch back-and-forth between the two sort modes at will.    When WWPlus 
starts it will be in the last used mode.    The mode for each .QUE file is kept with the file.

A visual cue to the sort condition of the list is provided by the font color - dark red when unsorted and dark 
blue when sorted.



List Details
This option in the File menu has two options, File Name Only and Full Path and File Name.    File Name 
Only will remove drive and path information, while Full Path will include all directory/subdirectory 
information for each file.    In the latter case, the file name may be scrolled off to the right of the queue, 
making the entries difficult to read.



Monitor Com Port
Selected from the Preferences submenu of the Wallpaper menu, this option allows you to select a 
particular com port to monitor.    If WWPlus detects that another application has opened this port, it will not 
allow the timer to cycle (which otherwise might interrupt serial communications).    This option is intended 
to be used only with a port that has a modem attached.    It will probably not work with other devices such 
as serial printers.    If an application normally keeps a port open, such as a Fax/Modem application, then 
wallpaper changes will never occur.    If you are running Windows NT, this option is disabled to keep from 
disrupting serial communications.



Add Button
The "Add" Button is used to add a new image to the Wallpaper Queue.    Pressing this button is the same 
as choosing "Add Image File" from the File menu; the keyboard shortcut is CTRL-A.    Pressing this button 
will cause a dialog box to appear for browsing through drives and directories looking for bitmap files which 
can be selected for addition to the queue.    Files can have ,BMP, .RLE, .GIF, .PCX, .TIF, .ICO, .TGA, 
or .JPG extensions.    You may use the tiling option buttons to turn tiling on or off for the added files - the 
default will be the condition of the Tiling on/off Option at the time the Add Button was pressed.    You may 
change the tiling for a file or files later, by first clicking on the filename(s) in the Wallpaper Queue and then 
changing the Tiling on/off Option. The image will be positioned according to the setting of the default 
origin point.

You may add an image to the queue more than once to increase its display frequency.



Queue File Menu Options
WWPlus allows multiple configuration file called "queues."    A queue file a list of the wallpaper files for that 
queue.    Wallpaper files may appear in many different queues.    When a queue is loaded, its name will 
appear in the status line at the lower left of the WWPlus screen.    Clicking on this name will pop up a list 
of all .QUE files that are in the same directory, for immediate change. 

There are five menu options in the File menu for use with queues: "Start New Queue File," "Change 
Queue File," Clear Queue File, "Save Queue File As and Delete Queue File.    The Change Queue File 
option may be used to change to queues that are not located in the same directory as the current queue.

Normally, WWPlus will start with the last used queue.    You may, however, specify a queue on the 
command line.    An example would be C:\WWPLUS\WWPLUS.EXE C:\WWPLUS\SCENERY.QUE, which 
would start the program with a scenery.que loaded.      If you associate the .QUE extension with WWPlus, 
you may start a queue by double-clicking a .que file in file manager, or you may setup different icons with 
different queues.

If you start a second instance of WWPlus with a queue specified on the command line, the program will 
prompt you to see if you want to end the previous instance.    You may not have two copies of WWPlus 
running at the same time.

Each .QUE file will use about 5K of disk space in the .QUE file.    If you delete a file this space is not 
recovered, although it does get used when a new file is added (before any more space is used at the end 
of the file).    Using the Clear Queue File option will remove all of the file information and reduce the .QUE 
file size to a minimum.    Use this option when you want to start over adding a new list of files.    Delete 
Queue File means to remove the .QUE file from your hard drive.    Both commands will prompt for 
confirmation, and the latter command will follow with a dialog to select a new queue.    If that operation is 
canceled, the queue will become Untitled.    If an Untitled queue actually exists in your WWPlus directory it 
will become the active queue.

Save Queue File As will make a new copy of the existing .QUE file under a new name which you select.    
It will not delete the previous named queue file.    If you are using the function to rename a queue you 
should change back to the previous queue and delete it, or delete it using File Manager functions.



Delete Button
The "Delete" Button will be disabled (grayed) unless an entry has been selected in the Wallpaper Queue.  
Pressing this button is the same as choosing "Delete Image File" from the File menu; the keyboard 
shortcut is CTRL-D.    If a selection has been made, it will be deleted. 

The program will offer two choices: delete from queue only or from the queue and your hard drive.    The 
latter will delete the file itself.    This will not affect the current visibility of the image if it is showing on the 
desktop.    If the wallpaper is listed more than once, only the selected occurrence will be deleted.    In that 
case, if the file was deleted, a warning message will occur when the program attempts to display the 
image from the other entry.

Multiple file selections are allowed in the queue list.    The chosen action (Delete from queue only, or 
Delete from hard drive) will be performed on all selected files.



Change Wallpaper Button
The "Change Wallpaper" Button functions differently depending on whether an image has been selected 
in the Wallpaper Queue.    Pressing this button when an image is selected is the same as choosing "Make 
Change" from the Wallpaper menu (keyboard shortcut: CTRL-M), which makes the selection the current 
wallpaper and displays on the desktop immediately.    The timer will reset automatically.    If multiple files 
are selected, the first image in the list will be used.

When there is no image selected in the queue, this button will cause a change of wallpaper exactly as if 
the timer had cycled.    The next image will be either randomly or sequentially selected depending on the 
setting of the Display Order option in the preferences menu.



Clear Screen Button
The Clear Screen button will clear any wallpaper showing from the screen.    Pressing this button is the 
same as choosing "Clear Screen" from the Wallpaper menu; the keyboard shortcut is CTRL-C.    Close 
the program or turn the timer off to keep a wallpaper from being displayed when the timer cycles.



The Wallpaper Queue
The "Wallpaper Queue" is a list of bitmaps that you wish to use as wallpapers.    You can show all of the 
images in the queue in "Thumbnail" form by choosing View Image Thumbnails from the Images menu.    
You can add any appropriate bitmap image to the list via the Add Button or Import Button.    You can make 
a specific image occur more often by adding it to the queue more than once.    You may also add images 
to the queue by means of Drag and Drop from the File Manager.    You may display the list in an 
alphabetically sorted manner, or unsorted, see Sort Image Files. You may display the list with or without 
path information, see List Details.

You may have multiple queue lists; see Changing Queues 

For the following actions you must first select a wallpaper in the queue.    This means that you must click 
once on a file name, then perform the action.

Delete Button. 
Tiling on/off 
Position Wallpaper 

The first two of these options will work on multiple files at once, if they are selected.    The queue list is an 
Extended Selection list box; holding down the left mouse button while dragging across file names will 
select them all, clicking on one and then holding the shift key down while clicking another will select all 
that are in-between, and holding the control key down while selecting individual files with the left mouse 
button.

Single selections may also be made using the keyboard up and down arrows, using the spacebar as a 
Single-Click and the Enter key as a Double-Click.    This does not work for multiple selection.

The Change Wallpaper Button.    is a special case where the function will change depending on whether a 
selection is current in the queue.



Timer Panel
The Timer panel in the status bar at the lower right of the WWPlus screen indicates whether the wallpaper 
change timer is on or off and, if on, shows the time remaining until the next wallpaper change.    The timer 
will toggle on/off by clicking the panel with the mouse.    When off, the panel displays in red letters Timer: 
off.    When on, the lettering is green and an example would be : Timer: 1.5 which would mean the next 
wallpaper change would occur in 1 and 1/2 minutes.    Set the amount of time between changes with the 
Wallpaper Change Time menu item in the Wallpaper menu.



Tiling on/off Option
Wallpapers may be displayed either Tiled or not.    The Tiling Off option means that the wallpaper will be 
shown once at the origin point (see Adjusting wallpaper placement on screen).    With Tiling on, wallpaper 
that is smaller than the screen size will be shown in multiple images to fill the entire screen.    The 
condition of this setting when a new wallpaper is added to the queue will determine the initial setting for 
that wallpaper.    Clicking this icon is the same as choosing the Tiling On/Tiling Off menu item in the 
Wallpaper menu (only one option at a time will show in the menu; clicking it will toggle to the opposite 
setting).

To change a wallpaper's setting, select it in the queue and then change the switch.    You may choose 
multiple images in the queue and apply a setting to all of them at once.

If you have the Resize Wallpaper to Screen option enabled it will only affect non-tiled images.



Registration

Don Bradner
Arcata Pet
600 F Street
Arcata,CA 95521-6301

WWPlus copyright ©1992-1996 by Don Bradner.    WWPlus is Shareware.    Click here to print a 
Registration Form and send it with $20.00 to the author at the above address.    California residents 
please add $1.45 for state sales tax, and Non-US users please add $1.00 for Air Mail service. See Author 
Support for information on contacting the author

CompuServe members may register on-line.    Go SWREG, the program registration number is 2213.    
Regardless of the method of registration, you will receive a copy of the most recent version of WWPlus 
and a registration key that will eliminate the startup screen. This registration key will work for all future 
versions of WWPlus as well, including an eventual 32-bit version.    See Upgrading to new versions.    
Some high-resolution photographic images in .JPG format will also be included, and you may also include 
2 photos or slides of your own for free scanning.

Commercial use:    WWPlus may be used commercially, as long as there is a registered copy for each 
computer/terminal that is using it.    Bulk licensing programs are also available.



Author Support
The author is very interested in providing support for this program.    Feel free to contact him in any of the 
following ways:

Mail:
Don Bradner
Arcata Pet
600 F Street
Arcata, CA 95521-6301

FAX: (707) 822-6570
Phone: (707) 822-6350 10am-5pm Pacific Time, ask for Don

CompuServe: 76130,1007
AOL: DBirdMan
Internet mail: dbirdman@arcatapet.com 
Home Page: http://www.arcatapet.com

Sometimes it is desirable for a user to send the author files, such as specific graphics images that 
WWPlus is having problems with.    Compuserve and AOL members may attach files to E-Mail on those 
systems.    Internet users may send files by FTP to redshift.com/arcatpet/incoming

If sending files by FTP, please send E-Mail to inform the author so the incoming directory will get checked.



Current Wallpaper
The Current Wallpaper area at the bottom of the WWPlus screen displays the complete path for the 
currently displayed bitmap.    If there is no wallpaper displayed, the listing will be "(None)"



Edit Image
Pressing this button is the same as choosing "Edit Image" from the Image menu; the keyboard shortcut is 
CTRL-E.    If you have previously selected an entry in the Wallpaper Queue, clicking this button will open 
the Picture Editor with the selected entry displayed, ready to edit.    Otherwise the editor will open with the 
file load dialog to load an image.    Use the latter technique to edit an image that is not in your current 
queue.



Picture Editor
The Picture Editor is a major feature of WWPlus.    You can access the Picture Editor by selecting a file in 
the Wallpaper Queue. and pressing the Edit Button.    You can also access the Editor from the Thumbnail 
Display.    When the image is displayed, you may edit it in a variety of ways.    Choose an option below to 
learn more about the use of editing features.

Caption information

Edit Options:
Resize SubMenu:

Resize
Re-size to 640x480 Proportional
Re-size to 640x480 Stretch
Re-size to 800x600 Proportional
Re-size to 800x600 Stretch
Re-size to 1024x768 Proportional
Re-size to 1024x768 Stretch

Crop
Adjust Crop Boundaries
Rotate
Mirror Horizontal
Mirror Vertical
Tune SubMenu:

Brightness/Contrast/Gamma
Sharpen
Sharpen More
Soften
Soften More

Reduce colors to 16
Reduce colors to 256
Copy
Paste

File Options:
Open
Save
SaveAs
Add to Wallpaper Queue



Add to Wallpaper Queue
Add to Wallpaper Queue in the File Menu will add a listing for the current image in the Picture Editor.    
to the WallpaperQueue.    You will only be able to add images in these image 
types: ,BMP,,RLE, .GIF, .PCX, .TIF, .TGA, .ICO, and .JPG.

You may add an image more than once to increase its display frequency.



Copy
The copy option in the Picture Editor's Edit menu will copy a displayed image to the Windows Clipboard, 
where it can be pasted into other applications.



Paste
The Paste option in the Picture Editors Edit menu will only be active (not grayed) when the Windows 
Clipboard contains an image that can be read by this program.    The pasted image will replace any image 
already displayed; a prompt will be issued to save the current image if it has been altered.



Load File dialog box
The Load file dialog is shown when the Add button or Import button is clicked, as well as from the Open 
menu option in the picture editor.    You may browse through your directories to find any image file which 
WWPlus recognizes.    A handy preview function is included.    Select a file and click the Preview button.    
A small "thumbnail" version of the file will appear in the box above the button.    When you have found an 
image that you wish to load, click OK.    To exit the dialog without making a selection, click Cancel.

Multiple file selection is allowed.    If the files are not contiguous in the directory, hold down the CTRL key 
while clicking each file.    To select a large number at once, click the first one and then scroll to the last 
one; hold down the Shift key and click the last one.    The maximum number of files which may be in a 
queue is 1000, but the number which can be added at one time is around 200 (varies with the lenth of the 
file names and path).



Save As dialog box
The Save As dialog is shown when a file is Imported, when Save As is chosen in the picture editor, and 
when Save is chosen in the picture editor but the file is not of a type that can be saved by WWPlus.    You 
may use the dialog to change the name and/or the file extension.    Note that the file extension is 
governed by the option selection at the lower right of the screen.    If you name a file "MYFILE.BMP" and 
select .GIF as the extension, the file will be saved as "MYFILE.GIF" and the type will be .GIF.    When you 
choose a file type, you may check the "Make Default" checkbox for that extension.    If you change 
directories, the new directory will be the one showing the next time you use the dialog.    The .RLE 
and .ICO filetypes that are supported for loading a file are not supported for saving.

When the .JPG file type is selected, a JPG Quality Value option will be available.    The value shown 
determines how much compression will be used and how much of the original image quality will be 
retained.    Higher numbers equal larger files and higher quality.    At very low numbers the quality will be 
terrible but the file will be very small.    Numbers allowed range from 5 to 95 with a default of 75.



Resize
This menu option will allow you to re-size an image in the Picture Editor.    You will see a dialog box with 
various options.    If you want to re-size an image to 80% of its original size, input 0.8 in the Scale box.    
To re-size 125%, enter 1.25.    You may enter a new width and/or height directly - if the Proportional Re-
size checkbox is checked, the other dimension will also change to keep the same proportions.    
Otherwise, the image will stretch to accommodate the new width or height.

The Preview button allows you to see the effect of your selection without changing the underlying image. 
The OK button will alter the image to match the new settings.    Cancel restores the unaltered image.



Resize to 640x480 Proportional and Stretch
Operates the same as Resize except that the dimensions are fixed for a VGA screen.    This function can 
produce an image proportional to the original, which means that if the ratio of the original's width-to-height 
is less than 1.33 the produced width will be less than 640, and if the ratio is greater than 1.33 the 
produced height will be less than 480, or it can stretch the image to fill the entire space.



Resize to 800x600 Proportional and Stretch
Operates the same as Resize except that the dimensions are fixed for an SVGA screen. This function can 
produce an image proportional to the original, which means that if the ratio of the original's width-to-height 
is less than 1.33 the produced width will be less than 800, and if the ratio is greater than 1.33 the 
produced height will be less than 600, or it can stretch the image to fill the entire space.



Resize to 1024x768 Proportional and Stretch
Operates the same as Resize except that the dimensions are fixed for a 1024x768 (8514-type) screen. 
This function can produce an image proportional to the original, which means that if the ratio of the 
original's width-to-height is less than 1.33 the produced width will be less than 1024, and if the ratio is 
greater than 1.33 the produced height will be less than 768, or it can stretch the image to fill the entire 
space.



Crop
Crop allows you to select an area of an image displayed in the Picture Editor.    Make your selection by 
moving the mouse cursor to a starting corner of the area desired.    Press and hold the mouse button 
down, "sweeping" over the selected area.    An outline box will display the chosen area, and the Picture 
Editor top caption bar will display the size of the area chosen (in pixels).    When the cropping selection is 
completed, release the mouse button.    If a different selection is desired, repeat the above steps; the first 
selection will be erased as the new selection is begun.

If the region you have selected is not quite right, you may choose to adjust the selected area.    See 
Adjusting Crop Boudaries

When you have a selection that you wish to use, select Crop from the Edit Menu.    The window frame 
will shrink to match your selection.



Adjusting Crop Boundaries
Whenever there is an active cropping region, there will be an entry in the Edit menu of the Picture Editor 
for "adjusting crop boundaries."    Selecting this option will show a form with the positions of the left, right, 
top, and bottom borders of the cropping region.    You may directly enter new numbers to more precisely 
position your cropping area.    If you choose numbers which are outside the image borders the border 
positions will be used instead.    Choose OK to accept the changes and you will see the rubber band 
redrawn at your newly set coordinates.



Rotate
The Rotation submenu has options to rotate an image in 90 degree increments left or right (counter-
clockwise or clockwise) as well as 180 degrees.    Rotating 180 degrees is not the same as Mirror 
Vertical, which changes the orientation of the image.    Rotating 90 degrees 4 times in the same direction 
will restore the original image.



Mirror
There are two mirror choices in the Edit Menu.    Mirror Horizontal will flip the image displayed in the 
Picture Editor left-to-right.    Mirror Vertical will flip the image top-to-bottom.



Brightness/Contrast/Gamma adjustment
The Brightness, Contrast and Gamma controls allow some alteration of these characteristics of an 
image displayed in the Picture Editor.    When this option is selected from the Tune SubMenu of the Edit 
Menu, a floating dialog with three slide bars will on the screen.    Sliding the top control will affect the 
image's overall brightness, while the second bar will affect the contrast between light and dark portions of 
the image.    The third bar controls Gamma, which will affect the brightness of the midtones primarily.    
Using the three together will have various effects, which will be immediately visible when the mouse 
button is released.    When editing is completed to your satisfaction, press the OK button, or if you feel 
that the original image is preferable, reject the edited version in favor of the original by clicking the Cancel 
button.    The reset button returns all of the values to their original point while allowing you to continue 
experimenting.



Sharpen and Sharpen More
Sharpen and Sharpen More are two of the options in the Tune SubMenu of the Edit Menu.    With these 
options, WWPlus will search for edges in the image and will increase the contrast along those edges, 
thus increasing the apparent sharpness, or focus.    Repeatedly choosing Sharpen will increase the 
apparent sharpness.    Sharpen More is the equivalent of choosing Sharpen 3 times in succession.



Soften and Soften More
Soften and Soften More are two of the options in the Tune SubMenu of the Edit Menu. With these 
options, WWPlus will search for edges in the image and will decrease the contrast along those edges, 
thus decreasing the apparent sharpness, or focus.    Repeatedly choosing Soften will decrease the 
apparent sharpness.    Soften More is the equivalent of choosing Soften 3 times in succession.



Open
Open in the File Menu allows you to place a new image in the Picture Editor, replacing the existing 
image.    You are not limited to the list of wallpapers in the Wallpaper Queue; any valid image may be 
loaded in any format recognized by WWPlus:    ,BMP, .RLE, .GIF, .PCX, .TIF, .TGA, .ICO, or .JPG.



Save
Save in the File Menu will save the image that is currently displayed in the Picture Editor,as long as the 
image is in a format which WWPlus can write:    ,BMP, .GIF, .PCX, .TIF, TGA or .JPG. ,RLE and .ICO, can 
be loaded but not saved.    If you try to save an image in a format which WWPlus cannot write, you will be 
prompted to use Save As instead.



Save As
Save As in the File Menu is used to change the name, directory, or file type of an image in the Picture 
Editor.    You will only be able to save in the wallpaper types, .BMP, .GIF, .PCX,, .TIF .TGA or .JPG.

When .JPG is selected, there will be an Options button visible to set the quality factor.



Import Image
The "Import" selection in the file menu is used to add a new image to the Wallpaper Queue and change 
the format at the same time.    The keyboard shortcut is CTRL-I.    Choosing this item will cause a dialog 
box to appear which will allow you to browse through your directories looking for bitmap files which you 
can select to add to the queue.    Files may have ,BMP, .RLE, .GIF, .PCX, .TIF, .TGA, .ICO, or .JPG 
extensions.    Tiling works as described in the Add Button topic.    Another dialog box will prompt you for a 
filename and extension to save the file as, limited to the same extensions less .RLE and .ICO.



File Menu
The File menu contains items for adding, importing and deleting files from the queue.    It also contains 
items for creating and deleting queue files themselves, as well as items which control the display of the 
files in the queue (sort and list details). 

Menu items include:

Add Image File 
Import Image File 
ReLink Image File 
Delete Image File 
Sort Image Files
List Details
Start New Queue File
ChangeQueueFile
Clear Queue File
Save Queue File As
Delete Queue File



Preferences
This menu contains items that affect the way WWPlus works.    It allows you to change a number of 
defaults to customize the program to your own liking.    Click any of the topics below to get information on 
that topic.

Resize Displayed Image
Display Order
Set Default Origins
Icon Type
Correct Screen Gamma
Use ToolTips
Monitor Com Port
Disable Auto Preview



Change Wallpaper at Start
By default, WWPlus does not change your wallpaper when the program is started.    If you want it to do 
so, check this option.    If WWPlus is in your Program Manager Startup Group, you will get a new 
wallpaper whenever you start a Windows session.    You will also get a new wallpaper whenever you 
change queues.    This option will slow the loading of Windows.



Remove Wallpaper at Exit
When this option is enabled, WWPlus will clear any wallpaper when the program ends.    This can be 
useful if you normally have WWPlus running all of the time, and the only time it exits is when you exit 
Windows.    With this option, there will be no wallpaper when you next start Windows, resulting in a 
quicker load time.



Icon Type
WWPlus allows three options for displaying the icon of the minimized program, normal, hidden, and 
special multipurpose.    These options may be toggled in order by clicking the icon that is to the left of the 
Help icon, or they may be selected directly as sub-menu items in the Preferences menu.

A normal icon is the one that would display by default at the bottom of the screen (or in the taskbar if a 
Windows 95 type interface is being used).    A hidden icon completely disappears.    WWPlus will not even 
appear in the task list.    If you select this option but need to restore the main program screen you may do 
so by starting the program again from the WWPlus group (or the Startup Group if it is installed there).    
Instead of another copy of the program, the first running copy will be restored.

The multipurpose option displays an icon-sized window divided into 4 segments, each with a different 
function.    Windows 95 users who choose this option will have an additional option to place any or all of 
the segments in the task bar tray.    See Using the Taskbar tray for additional information. 

With the regular multipurpose icon, the segments have the following functions:    The windshield wiper 
portion of the icon will immediately clear the screen of any wallpaper.    The clock portion will toggle the 
timer on and off; it will have a green edge when on and red when off.    The lightning bolt image will cause 
an immediate wallpaper change, and the remaining icon turns the screen saver on and off.    It will be 
yellow with the word on when on, and gray with off when off.    Double-clicking the Control Box will restore 
the main WWPlus window.    The top bar can be used to drag the icon to a desired location, it will return to 
that location in the future.

There is an Always On Top option in the control menu that will make the Multipurpose icon float above 
other application windows.

Keyboard shortcuts:    When the multipurpose icon is active (the top bar will have the color of an active 
window), you may use the following shortcuts:

CTRL+T will toggle the timer.    CTRL+C will clear the screen.    CTRL+S will start the screen saver.    The 
Spacebar will change the wallpaper.    ENTER will restore the main window.    ALT+F4 will end WWPlus.    
F1 will provide this help screen.



Set Default Origins
This item in the Preferences sub-menu sets the default location for each newly added wallpaper image.    
You may change the individual setting later - see Adjusting wallpaper placement on screen



Images Menu
The Images menu has three options: Edit Image will load the Picture Editor, either with a file selected 
from the queue or with a load dialog if no image was selected.    Batch File Conversion, as the name 
implies, allows you to convert the format of a number of files at one time.    View Image Thumbnails will 
load small sketches of each image for viewing/editing (see Thumbnail Display).



Help Menu
The Help Menu provides several options: Overview, which will display an image of the program where 
you can click on an element to see its description; Contents, which displays the table of contents; Search 
for help on..., which allows the helpfile to be searched by key word; Author Contact & Support, which 
takes you to that topic, and About, which provides current version information for WWPlus.    The help icon 
(question mark) is the same thing as Help/Overview.



File Formats
Information on the file formats supported by WWPlus:

.BMP and .RLE
Files with .BMP extensions are bitmapped images created by tools like Windows Paintbrush.    .BMP is 
the native format for Windows wallpaper.    There are a few .BMP files distributed with Windows 
specifically for use as wallpaper.

This is the fastest format available, but requires the most disk space.    It does not require any conversion 
or decompression by WWPlus, so the only time required to display a new wallpaper is the time it takes to 
read the image from the disk.    Excellent for small images that are "tiled" (displayed as multiple images to 
cover the desktop space).    This format is usable for all color levels from 16 to 16-million.    .RLE is a 
compressed form of .BMP.

.GIF
The Compuserve Graphics Interchange Format, pronounced "Jiff," offers great compression of images up 
to 256 colors without loss of quality.    It is not usable for images with more colors.    This format is 
generally the best choice when disk space is limited and the image has no more than 256 colors.    There 
is a noticable delay while WWPlus decompresses the image and converts it to .BMP for display, although 
the faster the computer the shorter the delay.    The .GIF format contains compression technology that is 
patented by the Unisys corporation, and as of 1/1/95 became liable for royalty    payments by software 
developers.    See the full statement in the README.TXT file.

.ICO
These are Windows icon files, 32x32 pixels and 16 colors.    You may use these as tiled wallpaper with 
WWPlus.    The temporary .BMP file that WWPlus creates will have a color depth equal to the maximum 
number of colors that your monitor will support. WWPlus will load them, but does not have the facilities to 
create or save .ICO files.

.JPG
Files with .JPG extensions are "JPEG" compressed.    JPEG stands for Joint Photographic Experts 
Committee.    This format is only suitable for 24-bit (16-million color) images, although WWPlus will allow 
you to save 256 color images.    It is also "lossy," which means that the compression involves some loss of 
quality.    The resulting file size is quite small, but takes a long time to decompress and display. JPEG is 
particularly unsuited for images with large areas of solid colors and sharp edges.

JPEG does a very good job of compression, and with most pictures the resulting image is comparable to 
the original.      There is a variable amount of compression available, with greater loss of quality as the 
image is further compressed. Whenever the File SaveAs dialog is invoked and .JPG is selected as the file 
type, there will be a field visible which allows you to change your quality factor.    WWPlus will store your 
setting in its global configuration, so you if you establish a standard quality factor for your needs it will be 
the future default.    When WWPlus does not find a previously selected setting, the default is 75.    
WWPlus allows a quality setting of 5 to 95, with 5 being the most compressed and 95 being the least 
compressed.    A 622,134 byte test file produced sizes of 5,381 bytes at a setting of 5, and 75,809 bytes at 
a setting of 95.    The image was very deteriorated at the lower setting, while it was indistinguishable from 
the original at 95.    Further testing for this image showed very acceptable results at a setting of 75, with a 
file size of 25,554 bytes.

Editing a JPEG image and saving it in .JPG format again will result in additional losses of quality.    Editing 
should always be performed on the original 24-bit image before compression is done.

There are many non-standard forms of JPEG.    WWPlus should read any JPEG image conforming to the 
JFIF standard, but may not be able to read images produced by non-standard programs.    An example 



would be GIF2JPG, which can produce a proprietary JPEG file called HSI.    Older versions of the 
program did this by default; newer versions produce JFIF compatible files by default.

WWPlus also has problems reading 256-greyscale images, which are not JFIF-standard.    If another 
application is available which can read the file, it may be converted to RGB (still grey) and then saved, 
after which WWPlus will read it.

.PCX

.PCX is a format developed by the Z-Soft corporation for their line of PC Paintbrush programs.    Windows 
Paintbrush is also able to read and save this format.    It provides some compression for images with color 
levels up to 256 when compared to ,BMP files, but not as much as a ,GIF.    Like .GIF, .PCX can not be 
used as a native wallpaper format, but WWPlus will take care of the translation.    There is less noticeable 
delay when using .PCX than with .GIF. The .PCX format can use color levels up to 16 million, but file size 
actually increases when 24-bit files are used.

.TIF and .TGA

.TIF is the extension used with Tagged Information File Format (TIFF) files    .TGA is called "Targa."    Both 
are primarily formats for storing 24-bit (true-color) 16-million color images and gray-scale images in 
desktop publishing.    WWPlus can read the formats, and use them as wallpapers, but there is no space 
advantage and they will load slower than .BMP.    If you have a Tiff or Targa image that you would like to 
use, Import it and save it in .BMP format (or convert it to .GIF if it has 256 colors or less).    Tiff files may 
contain more than one picture.    If that is the case, WWPlus will only read the first image. .TIF is usable 
for all color levels, 16 to 16-million, while .TGA is usable from 256 to 16-million.



Wallpaper
Wallpaper is the term used to describe an image being displayed on the Windows desktop as a 
background.    It can be a small image that is repeated many times (tiled), or a single image of any size up 
to the full screen size.

Obtaining Wallpaper Files
Graphics images suitable for use as wallpaper are abundant from most online sources.    These files will 
usually be in .GIF or .JPG format.    If you have access to a scanner, you can turn your own photos into 
wallpaper.    A number of the author's scans are available to internet users by FTP from 
redshift.com/arcatpet/wwplus/images.    Thumbnails of these images are available from the author's home 
page: http://www.arcatapet.com



The Author



Bitmaps
A bitmap is an image stored as a pattern of dots.    These images can be stored in a number of graphics 
formats, but the only formats which can be used as wallpaper directly by Windows are .BMP and .RLE.    
With WWPlus, you may use .GIF, .PCX, .BMP, RLE, ICO, TIF, .TGA, and .JPG as wallpaper, and the 
program will interpret the files as necessary for use by Windows.

Where to get bitmaps
Several .BMP files are included with Windows for use as wallpaper.    Additionally, you can draw your own 
bitmaps with Windows Paintbrush.    If you have a scanner, you can scan images and store them as 
bitmaps.    Many computer stores and printing businesses offer custom scanning to order.    On-line 
services have thousands of files which can be used as wallpaper.    Most of these files will be in .GIF 
format, which cannot directly be used as wallpaper except with this program.

If desired, the author of WWPlus will provide two free scans when registering the program.      See the 
Registration Form for more details.



Files and Uninstalling
When WWPlus is installed, a program (UNINSTAL.EXE) and a data file (INSTALL.LOG) are placed in the 
WWPlus directory.    The following information is provided to aid in removing the program in case those 
files are lost or damaged.

Files distributed with WWPlus

WWPSETUP.EXE This file contains all of the program files.    Running it will install of the files where they 
belong, and will also produce a record and program that can be used to uninstall this package.
README.TXT a text file that explains the program.    It is placed outside the main install program so that 
it is readable before the program is installed.
VENDINFO.DIZ, FILEID.DIZ Information files for shareware distributors and online services.    These 
explain distribution rights and allowable methods.

Files installed by WWPlus
Main Program directory files
WWPLUS.EXE, WWPLUS.HLP, GAMMA.PCX, README.TXT, UNINSTAL.EXE, INSTALL.LOG.

Windows directory file
WWPSAVR.SCR

Windows\System directory files
IKENG16.DLL, IKJPG16.DLL, IKCOL16.DLL, IKDSP16.VBX, WWPLIBR.VBX, CALL32.DLL.

Registered users will have one additional file: WWP_REG.KEY.    This file must be in your WWPLUS 
directory, and will keep the startup shareware screen from appearing.    If you upgrade to a new version of 
WWPlus, do not delete this file - it will work with all future versions.

Files required by WWPlus
VBRUN300.DLL A "runtime" library for programs written in Visual Basic 3.0.    This file is almost always 
available from any source for WWPlus.    From on-line sources, look for VBRUN3.ZIP or VBRUN300.ZIP. 
It must be placed in your Windows\System directory.

Files created by WWPlus
WWPLUS.BMP    This is a "temporary" file that WWPlus uses to translate non-standard images so that 
they can be used by Windows.    It is destroyed and recreated each time the wallpaper changes and the 
new image is not a .BMP file.    It is located in your WWPLUS directory.

*.QUE These are queue files used to store information about images in a queue.    They do not have to be 
in any particular directory, but the default is your WWPLUS directory.

WWPlus also creates some other temporary files with .TMP extensions.    Under normal use, the program 
will clean these up when it exits.    If the program crashes, it will clean them up the next time it is run and 
then exited normally.

Files Altered by WWPlus
CONTROL.INI    WWPlus will add a section called [ScreenSaver.WWPSaver].    Global parameters for 

both the program and the screen saver module are stored here.

Uninstalling WWPlus
If the UNINSTAL.EXE program and INSTALL.LOG file have been left intact in the WWPlus directory, 



running the program will remove all files that were installed with WWPlus.    The uninstaller does not know 
anything about the .QUE files and others created by the program, so those require manual deletion.    If 
the program is manually added to the Startup group rather than via the installer, you must remove it 
manually.    Likewise, if WWPlus is set to be your screen saver you will need to change that setting in the 
control panel.    If the UNINSTAL program has been removed, use the file list above to determine which 
files to remove. You may also wish to remove the CONTROL.INI section described above.



Distribution
WWPlus is shareware and may be freely distributed as long as all of the files are included and no fee is 
charged beyond a reasonable fee for distribution.    Registered users note:    Do not distribute your 
WWP_REG.KEY file.

All rights are reserved by the author (see Registration).



Troubleshooting
If your difficulties are related to slow operations with specific images, see Speed vs. File Size

Other difficulties running the program may be associated with a missing file, or a file that needs to be in 
the Windows or Windows\System directory but isn't.    See Files for details.    Another problem is a 
corrupted .QUE file.    Try starting the program with a different queue (See Changing Queues.), specified 
from the command line.    If this solves the problem, delete the offending queue.    This will not delete any 
of your wallpapers, just the queue listing

If you have an image that WWPlus will not display, it may be in a format that cannot be used.    There are 
some variations of .GIF and .PCX that are known to make problems for WWPlus.    There are many non-
standard versions of JPEG that will cause problems.    If you can load them into another image editing 
program you may be able to save it in a usable format.

If WWPlus runs correctly, but will not read .GIF or .JPG files, you may have a version of Image/Knife 
installed on your system that does not support these formats.    An example is the version of Knife that 
comes with Borland's Visual Solution Pack.    Since that file has a date newer than the one supplied with 
WWPlus, the WWPlus SETUP program will "respect" the newer version and not write over it.    Solution: 
expand the two files IMK.DL_ and KNIFE.VB_ that come with WWPlus to IMK.DLL and KNIFE.VBX, and 
copy them to your WWPLUS directory.    If you want to use the development versions that remain in your 
Windows/System directory you will need to exit WWPlus first. 

WWPlus expects image file names to match their formats.    If you have a .BMP image but give it a .GIF 
name, the program will not be able to read it.



Adjusting wallpaper placement on screen

Changing the wallpaper's location

By default, there are only two ways to display a wallpaper in Windows: Tiled, or single/centered.    Tiled 
wallpapers are repeated as necessary to cover all of the screen background.    With tiling off, wallpapers 
are displayed just once on the screen, normally in the center.    If the Wallpaper is the same size as the 
screen, tiled and centered will look exactly the same.    WWPlus contains options which allow you to 
change the position of a non-tiled wallpaper by setting the wallpaper origin (upper left corner position).
Combining this option with the option to confine an image to a specific size (see Resizing Wallpaper to 
Screen) allows many different looks to be achieved.    Users of Program Manager can set the screen up 
with ProgMan occupying the left or right half of the screen, with wallpaper appearing in the other half.    As 
an example, with a 640x480 screen you would set the maximum wallpaper size to 320x480 and set the 
origins to 1,0 or 320,0 to display the wallpaper at left or right respectively.

Setting the wallpaper origin

For all of the following, remember that a setting of 0 (zero) for X or Y coordinates will center a wallpaper 
on that axis.    You cannot set the upper left corner of a wallpaper to 0,0; use 1,0 or 0,1 instead.

First, select a default origin.    Click the Wallpaper menu on the main program screen, click Preferences, 
and then click Set Default Origins.    A dialog box will prompt you for settings and take care of the details. 
The next wallpaper change will incorporate the new settings unless a specific origin is set for that 
wallpaper.

To select a specific origin for a wallpaper, directly position the wallpaper, or change the settings. In either 
case, first select the file in the Wallpaper Queue. Choose Position Wallpaper in the Wallpaper menu.    
The program screen will be replaced by the image, which you may move by pressing and holding down 
your left mouse button.    When you have the image positioned where you want it, release the mouse 
button.    Double-click on the image or press the Enter key to "fix" the placement.    Press the escape key 
to exit without setting a new position.    Alternatively, you may enter the numbers directly in the X and Y 
coordinate boxes after selecting the file in the queue.    If either of the coordinates end up being zero, the 
box will read "centered" to remind you that it is not a true zero.



WWPlus Version 2.65

Order/Registration Form

Registration price is US$20.00, including postage within the US.

With a credit card you may order toll-free in North America: (800) 822-9085
Outside of North America please call: (707) 822-6417
FAX orders accepted at (707) 822-6570

You may register by E-Mail to any of the E-Mail addresses listed under Author Support as well.    Please 
provide the version number above and the other pertinent items from this form.    Registration Key can be 
provided by return E-Mail, on request.    A disk will otherwise be sent by mail.

By mail, with check, credit card, or money order in US Dollars to: Don Bradner/Arcata Pet
600 F Street

Arcata, CA 95521-6301

Compuserve members may register on-line:    GO SWREG, program registration number is 2213. 

Number of registrations desired _____ x 20.00 =                        $____________
      California residents add $1.45/registration sales tax              ____________
      Non-US add $1.00/registration for air mail                                          ____________

Total            ____________
Software will be sent on 1.44 meg 3-1/2 inch disk.    Send disk to:

Name:                                  ____________________________________________________

Mailing Address:            ____________________________________________________

City/State/ZIP/Country: ___________________________________________________

Daytime phone number (______)____________________ E-Mail, if any ___________

If paying with a credit card: Card type    �VISA        �MasterCard      �AMEX        �Discover

              Card Number:    ________________________________ Expiration Date: ________

              Signature to authorize charge: ________________________________________
(optional) Where did you get WWPlus?
�BBS or other on-line service. .    Which one? ______________________
�Software/Shareware Service.    Which one? ______________________
�Shareware CD-ROM.    Which one?__________________________
�Internet.    What site? __________________________________________
�Friend        �Other _________________________________________

You are welcome to include 2 prints or slides for free scanning if you would like.    Originals will be 
returned with your disk.    Please Specify the resolution desired (Maximum Horizontal/Vertical):
 __640x480    __800x600    __1024x768    __Other:_________
If none marked, image will fit 640x480.    image will be a 24-bit JPEG (which WWPlus can alter)

Comments to the author are welcome.    Tell me what you like, or would like changed or added.
Thank you for registering!



What Is Shareware?
Shareware distribution means try before you buy.    If you try a Shareware program and continue using it, 
the author expects to be compensated for his efforts to produce the program.    Individual programs differ 
on details -- some request registration while others require it, some specify a maximum trial period.    With 
registration, you get anything from the simple right to continue using the software to an updated program 
with printed material.    With WWPlus, you get the latest version plus a registration key that disables the 
startup shareware message.

Shareware authors are accomplished programmers, just like commercial authors, and the programs are 
of comparable quality.    (In both cases, there are good programs and bad ones!)    Copyright laws apply to 
both Shareware and commercial software, with the copyright holder retaining all rights, with the exception 
that the shareware author specifically grants the right to copy and distribute the software, either to all and 
sundry or to a specific group, while copying of commercial software is generally prohibited.

Because the overhead is low, prices are low also.    Shareware has the ultimate money-back guarantee -- 
if you don't use the product, you don't pay for it.



Hiding the program icon
While WWPlus is running an icon will normally be displayed at the bottom of your screen.    Once you 
have made all of the wallpaper selections that you desire, you may "turn off" the icon by selecting that 
option.    The icon on the program screen will change ('Xed'-out).    The program icon will not be visible, 
and the program will not show up in the Task Manager list.    If you need to change something in the 
program, go to your WWPlus group (or whatever group the program is installed in) and double-click the 
icon.    This will not run a new copy of the program, rather the existing copy will become visible.



WWPlus Screen Saver
WWPlus allows you to use your wallpaper images as a screen saver. Screen savers have several 
purposes.    Traditionally, they are used to prevent screen burn-in, which is a persistent image that shows 
even when the monitor is turned off.    Modern VGA and better screens do not usually exhibit burn-in 
problems, but it may be comforting to have the screen not remain static anyway.    Now the primary 
purpose for screen savers is entertainment and minimal screen security.

The WWPlus screen saver meets all of these purposes.    Cycling different wallpapers will avoid screen 
burn-in, provide entertainment, and provide security.    Security means that prying eyes will not see open 
windows on your screen, and can include optional password protection.

The screen saver uses a number of the configuration items from WWPlus, such as the display order, and 
has a number of other configuration items of its own.    Setup and configuration can be done from 
WWPlus via the Setup Screen Saver button and preference menu items or from the Windows Control 
Panel, Desktop icon.    Either method will give you access to the Screen Saver Configuration Dialog.

WWPlus must be running in order for the screen saver to work.    If WWPlus is not running, either when 
the screen saver is started due to inactivity or in response to the test button in the Windows Control 
Panel, the screen saver will start WWPlus.    If you don't want the screen saver to restart the program, and 
you don't want to have    to remember to manually turn the screen saver off when exiting WWPlus, set the 
menu item Screen Saver Off at Exit in the Screen Saver menu.    The corresponding Screen Saver on at 
Start item will make the WWPlus screen saver your active screen saver whenever the program is started.

Turning the regular WWPlus timer off and using the screen saver option can remove the problem of 
wallpaper changes disrupting your regular computer work.    All changes will occur only during idle times.

Speed and performance issues affect the screen saver in the same manner as anything else involving 
graphics in the Windows environment.    During portions of the image load and display process the system 
will be busy, so that when you move the mouse or press a key there will be no response until the new 
image is displayed.    You may have to re-move the mouse or press another key at that point.



Screen Saver off/on panel
Clicking this panel toggles the screen saver option on and off, which is duplicated by a menu item in the 
Screen Saver menu.    The panel caption will be green when the screen saver is on, and red when it is off. 
Configure the screen saver by using the Screen Saver Configuration Dialog. For general screen saver 
information, see the WWPlus Screen Saver topic.



Setup Screen Saver
This button will invoke the Screen Saver Configuration Dialog, from which you may make changes in the 
way the screen saver operates.



Queue Title
The Queue Title is the file name for the queue currently in use.    See Changing Queues for general 
information on this topic.



Screen Saver Configuration Dialog
The Screen Saver Configuration dialog is accessed from the Setup Screen Saver button on the WWPlus 
screen, the Screen Saver Setup option in the Preferences menu, or from the Windows Control Panel. 

There are three pages in the dialog.    WWPlus remembers the page most recently used, and will open to 
that page.    There is a test button to immediately see the results of changes, and a Restore Defaults 
button, which only affects the page which is showing.

Page 1, Entry Options:

Timer    - Turn the image-change timer on/off and set the time between image changes.    Range of values 
is 1-6000 seconds, default is 60 seconds.

Background color - Choose your regular desktop color (default) or black.    This area will surround any 
image that is less than full screen size.

Image Position - Choose center, or use whatever position is set in WWPlus for that wallpaper (default).

Startup Image - Choose none, next image, or current wallpaper (default).    When none is selected, the 
screen will blank to a solid color, as selected under Background Color above.    With the other two the 
image will transition from a view of the current screen into either the next or current wallpaper.    When 
current wallpaper is chosen and there is no current wallpaper, a static image of the current desktop will be 
displayed until the Timer interval has passed.

Keep Screen Saver On Top - By default this is on.    If it is turned off, any other window (clocks are 
typical, but also includes the WWPlus multipurpose icon when set on top) that has an on top setting will 
be displayed in front of the screen saver image.    Generally the only reason to turn this setting off would 
be if there is a process active which displays messages requiring a response, and the message is not 
visible to respond to.

Startup Delay - The interval in minutes after which Windows will start the wallpaper if there is no activity. 
Range is 1 to 99 minutes, with a default of 3 minutes.

Hot Corners - Moving your mouse to a Hot Corner will immediately activate or disable the screen saver. 
On the small representation of your screen, the immediate activation corner is shown as a plus (+) sign, 
and the disable corner is shown as a minus (-) sign.    To use a different corner, click in a blank corner and 
respond appropriately to the dialog.    For hot corners to function, you must have the WWPlus screen 
saver turned on.

Stop Changing - Checking this box will cause WWPlus to stop making screen saver changes after the 
set interval.    Range is 1 to 600 minutes, default is 60.    This option is provided for users of energy saving 
computers, where the computer will automatically go into low-power mode after a period of inactivity.    
The disk action required for screen saver changes will usually keep the low-power mode from being 
activated; setting this option will stop WWPlus from doing anything until the next mouse or keyboard 
action.

Page 2, Exit Options:

Wallpaper - Sets the wallpaper condition on exit from the screen saver.    Last Screen Saver will set the 
last image used as the current wallpaper (default).    This is the slowest option, and will cause a delay 
between the time the mouse is moved or a key is pressed and the restoration of your working screen.    
Restore Prev will leave the wallpaper as it was when the screen saver activated, and None will clear the 
screen completely.

WWPlus Wallpaper Timer - establishes the condition of the wallpaper timer in WWPlus when the screen 



saver terminates.    The options are On, Off, and Restore previous (default).

Mouse movement required to exit - Determines the amount of travel required to terminate the screen 
saver.    Movement is stored up, so a series of small moves will result in termination.    This storage is 
reset whenever the image changes.    The default is moderately sensitive.

Password Protect - You may establish a password that must be entered to end the screen saver.    This 
provides a minimal security for your computer when you are away from it.    The password you enter is 
recorded only for the WWPlus Screen Saver, and is not shared with other Windows screen savers.    If 
Password Protect is turned on but there is no password established, WWPlus will ignore this option.

NT Users -    There are additional options for NT users, and some of the existing exit options will not work 
as they do in other versions of Windows.    See Windows NT and WWPlus for more information.

Page 3, Effects

Note: Transition effects are video intensive.    They may not work properly with slow video cards or with 
bad video drivers.    It is a good idea to check with your video card vendor routinely to keep up with 
changes in video drivers.

Effects - There are 16 available screen saver change effects.    When none are selected (default), the 
next image is displayed immediately when the change interval has been reached.    The effects cause the 
image change to be gradual, producing a more dynamic appearance.    More than one effect may be 
chosen, in which case WWPlus will randomly select an effect from among those choices at each change 
interval.    Effects are not used when an image is tiled.

Use Common Palette - This option is only available when the system uses a 256-color display.    Use of a 
common palette will avoid annoying palette shifts between images, but many images will not look as good 
as they do when they have their own palettes.    Experiment to determine your preference.    This option 
has no meaning when there are no effects chosen.

Effect Speed - Adjust the effect speed to suit your personal taste.    This is hardware dependent - slower 
computers with limited graphics capabilities will probably need faster speed settings.    This option 
inserts a delay in most effects; in the Random Block and Drop Paint effects the speed is controlled by 
varying the element size.    A dissolve effect may be achieved by using Random Block with a slow 
setting.

For general screen saver information, see the WWPlus Screen Saver topic.



Position Wallpaper Button
Pressing this button, active only when an image is selected in the queue, is the same as choosing 
Position Wallpaper in the Wallpaper menu.    For more information, see the Adjusting wallpaper placement 
on screen topic.



Tool Tips
Tool Tips are small black-on-yellow labels that give a text caption for an icon.    When you position your 
mouse pointer over various of the WWPlus screen elements a caption will pop up that describes the 
element.    Once you are familiar with the screen you may want to turn these captions off, which you can 
do in the preferences menu.



Change Password
Use this dialog box to set a password for the screen saver. 
Choose one of the following for more information about the dialog box. 

Old Password

New Password

Retype New Password



Old Password
Use this option to specify the old password.    This box is unavailable if you are specifying a password first 
time.
Þ Type your old password in the box.



New Password
Þ Type your new password in the box.

Passwords can contain up to 20 characters, including punctuation, and are not case-sensitive.    An 
asterisk (*) appears in the box for each character you type.



Retype New Password
Use this option to confirm your password.

Þ Type your new password again in the box.



Drag and Drop
WWPlus supports Drag and Drop of files to the queue.    The program must be running when this is done. 
Select image files in the File Manager and drag them by holding the left mouse button down until you are 
over the WWPlus window, or the icon for the minimized program.    Release the mouse button, and the 
files will be added to the queue.    If you drop files that do not have extensions recognized by WWPlus, 
those will be ignored without harm.



DDE: Controlling WWPlus from other applications
If you are familiar with DDE (Dynamic Data Exchange), you may write macros in other applications that 
control two WWPlus applications: the Timer, and Change Wallpaper.

The information needed is as follows:

Application: WWPLUS

Topic: Wallpaper

Item: Command

DDE Function: DDEExecute

Available commands:    TimerOff, TimerOn, Change



Resize Wallpaper to fit screen
Choosing this item in the Preferences menu or clicking the resize icon will provide a dialog where you can 
specify that non-tiled wallpaper will be resized to full screen or to an alternative size.    Alternative sizes 
allowed range from a minimum of 32x32 (icon sized) to a maximum of twice the current screen size. 

You may also choose to have the image's aspect ratio maintained (Proportional) or have the image 
stretched to occupy the full area chosen (Stretch).

To keep wallpaper images confined to a specific area of the screen, first use this option to specify the 
maximum image size.    Then use the origin options to set the position of the image.    See the information 
on setting origin points.

Using the Resize Wallpaper option will slightly increase the time it takes to display wallpaper or screen 
saver images, with faster computers being least affected.



Correct Screen Gamma
This option, available from the Preferences menu, allows all displayed images to be automatically 
adjusted for gamma, or midtone.    When this option is selected, a dialog will be displayed which contains 
an adjustment target, along with a slider bar to adjust the gamma level.    For the target to show up, there 
must be a file called gamma.pcx (included with WWPlus) in your WWPLUS directory.    This target 
contains an area of neutral gray surrounded by an area of alternating black and white pixels.    Slide the 
bar until the center area appears to be the same shade as the surrounding area, then click OK.    
Displayed images will now be gamma corrected before display, either as wallpaper or as screen savers.    
If, after observing the results you feel that the images are under or over-corrected, reopen the dialog 
(unselect the menu item, and then re-select it) and make a small adjustment.    Smaller numbers will result 
in darker images.



NT and WWPlus
WWPlus is generally compatible with Windows NT (tested with versions 3.5, 3.51, and 4.0, but not all of 
the screen saver options will work, and some will work differently than with other versions of Windows.    
Due to the    nature of the security layer in NT, screen savers that are activated by NT operate in a 
separate virtual desktop and are not allowed to communicate with other applications.    NT also takes care 
of terminating the screen saver when there is activity, and does not allow the terminating screen saver to 
perform any tasks.

Because of this, when running under NT, some of the exit options will not work as described elsewhere in 
this help file.    Password protection works, but choosing the password from the WWPlus screen saver 
setup will have no effect, so that button will be disabled under NT.    If password protection is enabled, you 
will get NT's Locked Desktop message, requiring CTL-ALT-DEL and your normal logon password to 
regain the desktop.

Choices for the exit wallpaper will generally work; with NT, WWPlus sets the wallpaper under the screen 
saver at the same time as changes are visible.    If the screen saver happens to be terminated at the 
precise moment of change then the wallpaper may be out of sync.    This would be hard to do if you tried, 
but might occur occasionally by accident.    Choices for exit timer settings will not work.    The WWPlus 
timer on the main desktop will remain as it was when the screen saver activated, regardless of settings.

NT users will find an additional Exit option to boost the screen saver thread priority (in the screen saver 
setup).    If there is an intensive background application running, the screen saver may be very slow to 
respond to mouse or keyboard events, making it slow to restore your desktop.    By boosting the screen 
saver's priority you can insure that it will not be starved for processor time.    Tests have not indicated any 
adverse effects on background applications, likely because WWPlus is generally idle; it still is probably 
not good practice to boost the priority unless experience shows that it improves performance.

If you are using an advanced Windows 95-type shell with NT (3.51 or later), WWPlus will offer an option 
to place functions in the taskbar tray.    This is working with the beta 4.0 at this writing (March, 1996).    
See Windows 95 and WWPlus and Using the taskbar tray for more information.    WWPlus supports long 
filenames in NT on volumes that support such names.

Setting password protection in NT: The NT control panel will not allow you to set or unset password 
protection for WWPlus directly, however, if you access the WWPlus configuration from the main WWPlus 
screen and set password protection, it will work.    The next time you look at the desktop icon in Control 
Panel it will show password enabled.    The setup button in the NT control panel is disabled for WWPlus, 
due to problems with its use.    All configuration changes should be made by accessing the dialog from the 
main WWPlus program window.



Windows 95 and WWPlus
This version of WWPlus has been tested with Windows 95, and is fully compatible.    If you are using the 
normal Explorer Shell with Windows 95, WWPlus will detect this and will offer an option to place any or all 
of the four multipurpose icon functions in the taskbar tray.    See Using the taskbar tray for more 
information.    WWPlus also supports long filenames.    The author of WWPlus is working on a full 32-bit 
Windows 95 version of the program that will be available in the future.    That version will be available from 
the author's Internet site as well as from the major on-line services.    See Upgrading to new versions for 
details on where the files may be found.    Registered users of WWPlus will not have to pay any upgrade 
fees - the registration key file will work with all future versions.



ReLinking Files
When files are moved to new directories, their link to WWPlus will be broken.    Any attempt to use the file 
from the queue will result in an error, as the program will not be able to find the file.    In this case, select 
all affected files in the queue, and then choose ReLink Image File from the File Menu.    You will see a 
dialog that prompts you to browse for the proper directory.    After you have chosen a directory, the queue 
will be updated to reflect this new location for the files.    If you accidentally choose an incorrect directory it 
will not hurt anything, but the files will continue to produce a File not found error.

Hint: Choose List Details - Full Path and File Name, and Sort Image Files - Sort by Name, both in the File 
Menu, before selecting files to relink.    This will place all files from a particular directory together in the list 
and make multiple selection easier.



Wallpaper Menu
The Wallpaper menu has options controlling the use of images in the queue as wallpaper.    Using the Alt-
W key combination will pop up the wallpaper menu, and then you may select an option by pressing the 
letter underlined in that option or using the arrow keys to move to the option.    Some options also have 
"hotkey" combinations that are shown to the right of the option.    For example, holding down the control 
key and pressing 'C' will have the same result as selecting "Clear Screen."

Menu items include:

Make Change 
Wallpaper Change Time
Clear Screen 
Position Wallpaper 
Tiling On/Off
Change Wallpaper at Startup
RemoveWallpaper at Exit



Wallpaper Change Time
This item in the Wallpaper menu is used to set the interval between wallpaper changes when the 
wallpaper timer is on.    Allowable range is 0.1 minutes through 999.9 minutes.



Using the taskbar tray
A feature of the Explorer Shell interface used with Windows 95 (and soon with NT) is a Taskbar, where 
iconized programs reside along with the Start button.    One element of the Taskbar is a Tray where other 
applications may place icons for various functions.    By default, the tray contains a clock.    Systems with 
sound cards will have a speaker volume setting there, and when a print job is under way there will be an 
icon for the Print Manager.

When WWPlus identifies the presence of a tray, it will enable an option to place any of four functions in 
the tray: Clear Screen, Change Wallpaper, Wallpaper Timer On/Off, and Screen Saver On/Off.    To enable 
this option, cycle through the icon choices (by clicking the icon nearest the Help icon) until you get to the 
Multipurpose icon.    At that point you will see a dialog which allows selection of the old-style Multipurpose 
Icon or the placement of any of the functions into the tray.

When there are function icons in the tray, they have 3 available mouse actions.    Clicking with the left 
mouse button will perform the function.    Single-Clicking with the right mouse button will pop up a menu of 
choices, and Double-Clicking with the right mouse button will restore the main WWPlus program screen. 
Unlike the Multipurpose Icon, there are no keyboard shortcuts available.    If you are used to using the 
space bar to make the wallpaper change with the Multipurpose Icon, and want to continue to do so, then 
you will likely want to stay with the traditional icon.



Screen Saver Menu
The Screen Saver menu has options controlling the use of images in the queue as a screen saver.    
Using the Alt-S key combination will pop up the wallpaper menu.

Menu items include:

Turn Screen Saver On/Off
Screen Saver Setup
Screen Saver On at Startup
Screen Saver Off at Exit



Upgrading to new versions
New versions of WWPlus appear regularly.    Users provide good ideas for new features, and old features 
are always being improved.    When a new version is released, it is uploaded to at least the following 
locations:

CompuServe: Numerous forums, including WINAV, GRAPHSUP, PHOTOFORUM and EDRIVE.    File 
name is WWPLS.EXE (self-extracting archive).

America OnLine: Forum KeyWord: ArcataPet

internet:    The best source for current copies is the authors web page at http://www.arcatapet.com

Registered users are not required to re-register the program to upgrade.    Future versions will use the 
same registration key as the current version.    Registered users without access to one of the above sites 
may request disk copies from the author for a fee of $5 ($7 for non-US).

Registrants will always receive the most current version.

If you are pleased with WWPlus, you may also be interested in a program by the same author, 
ImgViewer/16.    ImgViewer/16 is a graphics viewing program that is an enhanced version of the editor 
included with WWPlus.    It works great when associated with file types, which you can do from within the 
program.    You can find ImgViewer/16 in the same places where WWPlus is found, usually with a file 
name beginning with IV16 or IMGV16.    On the author's ftp site it will be in the directory 
redshift.com/arcatpet/imgv16.    It is also available from the author's homepage, above.




